You can find the most up-to-date technical documentation on the VMware Web site at:
http://www.vmware.com/support/

The VMware Web site also provides the latest product updates.
If you have comments about this documentation, submit your feedback to:
docfeedback@vmware.com
Contents

About This Book 5

1 vCenter Server Heartbeat Introduction 7
   vCenter Server Heartbeat Overview 7
   vCenter Server Heartbeat Protection 7
      Server Protection 8
      Network Protection 8
      Application Protection 8
      Performance Protection 8
      Data Protection 9
   Communications 9
      vCenter Server Heartbeat Communications 9
      VMware Channel 9
      Principal (Public) Network 9
   Node Configuration 10

2 vCenter Server Heartbeat Installation 11
   Overview 11
   Environmental Prerequisites 11
      FireWall Configuration Requirements 11
   Common Requirements 12
      Server Architecture 13
      Application Component Options 13
      vCenter Server with SQL Server on the Same Host 14
      vCenter Server with SQL Server on a Separate Host 14
   Network Requirements 14
      Primary Server 14
      Secondary Server 14
   Installation Process 15
      Primary Server 15
      Secondary Server 19
         Renaming the Servers 21
   vCenter Server Heartbeat Console 22
      Installation of Client Tools 22
   Administering vCenter Server Heartbeat 23
      Navigate vCenter Server Heartbeat Console 23
      Add a vCenter Server Group 24
      Add a New Connection 24
   Post Installation Configuration 25
      Configuring VirtualCenter Plug-in with the Correct Credentials 25
      Configuring SQL Server Plug-in to run with the Correct Credentials 25
      Installing the View Composer Plug-in 26
      vCenter Server with SQL Server on a Separate Host 26

3 Installation Verification 27
   Verifying vCenter Server Heartbeat 27
   Failover Simulation 27
About This Book

This *Quick Start Guide* provides an introduction to VMware vCenter Server Heartbeat and guides you through the steps required to install vCenter Server Heartbeat in the most common environment and to perform basic configuration. This guide also provides a brief introduction to basic administration tasks and advanced configuration features, and provides pointers to more detailed information in other manuals.

Intended Audience

This guide assumes the reader has working knowledge of networks including the configuration of TCP/IP protocols and domain administration on the Windows™ 2003 and 2008 platforms, notably in Active Directory and DNS.

VMware Technical Publications Glossary

VMware Technical Publications provides a glossary of terms that might be unfamiliar to you. For definitions of terms as they are used in VMware technical documentation go to [http://www.vmware.com/support/pubs](http://www.vmware.com/support/pubs).

Document Feedback

VMware welcomes your suggestions for improving our documentation and invites you to send your feedback to docfeedback@vmware.com.

Abbreviations Used in Figures

The figures in this book use the abbreviations listed in Table 1.

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NIC</td>
<td>Network Interface Card</td>
</tr>
<tr>
<td>P2P</td>
<td>Physical to Physical</td>
</tr>
<tr>
<td>P2V</td>
<td>Physical to Virtual</td>
</tr>
<tr>
<td>V2V</td>
<td>Virtual to Virtual</td>
</tr>
</tbody>
</table>

Technical Support and Education Resources

The following sections describe the technical support resources available to you. To access the current versions of this guide and other publications, go to [www.vmware.com/support/pubs](http://www.vmware.com/support/pubs).

Online and Telephone Support

Go to [www.vmware.com/support](http://www.vmware.com/support) to use online support to submit technical support requests, view your product and contract information, and register your products.
Go to www.vmware.com/support/phone_support.html to find out how to use telephone support for the fastest response on priority 1 issues (applies to customers with appropriate support contracts).

**Support Offerings**

Go to www.vmware.com/support/services to find out how VMware support offerings can help meet your business needs.

**VMware Professional Services**

Go to www.vmware.com/services to access information about education classes, certification programs, and consulting services. VMware Education Services courses offer extensive hands-on labs, case study examples, and course materials designed for use as on-the-job reference tools. Courses are available onsite, in the classroom, and live online. For onsite pilot programs and implementation best practices, VMware Consulting Services provides offerings to help you assess, plan, build, and manage your virtual environment.
This chapter introduces vCenter Server Heartbeat and provides an overview of vCenter Server Heartbeat concepts. It contains the following sections:

- “vCenter Server Heartbeat Overview” on page 7
- “vCenter Server Heartbeat Protection” on page 7
- “Communications” on page 9
- “Node Configuration” on page 10

vCenter Server Heartbeat Overview

vCenter Server Heartbeat is a Windows based application specifically designed to provide high availability protection for vCenter Server configurations without requiring specialized hardware and provides a flexible solution that can be adapted to meet most business requirements for deployment. When discussing vCenter Server Heartbeat, it is beneficial to use common terminology to describe its configuration and what is occurring.

VMware describes the organization of servers based upon Pairs and Pair status. VMware refers to two servers with vCenter Server Heartbeat installed working together as a vCenter Server Heartbeat Pair.

Each server in the Pair is assigned both an Identity (Primary or Secondary) and a Role (active or passive). Identity is used to describe the physical instance of the server while the Role is used to describe what the server is doing. When the Identity is assigned to a server it normally will not change over the life of the server whereas the Role of the server is subject to change as a result of the operations the server is performing.

In its simplest form, vCenter Server Heartbeat operates as a vCenter Server Heartbeat Pair with one server performing an active role (normally the Primary server) while the other server performs a passive role (normally the Secondary server). The server in the active role hosts the vCenter Server components that are monitored. Data from the server performing in the active role is replicated to the passive (standby) server through a communications channel referred to as the VMware Channel. This communications channel is typically a standard 100Mb (or greater) LAN connection. In the event of a failure or manual action, the vCenter Server components that were protected by vCenter Server Heartbeat can be brought online on the Secondary server by switching roles.

vCenter Server Heartbeat Protection

vCenter Server Heartbeat provides protection on many levels including Server, Network, Application, Performance, and Data.
When a failure occurs or condition is reached that falls outside of established parameters, vCenter Server Heartbeat can take a variety of actions in response. For example, in the event of a server failure, the passive (standby) server will detect that the active server has failed and will immediately assume the role of the active server. This is referred to as a “failover” event. Additionally, vCenter Server Heartbeat can be configured to gracefully switch roles (switchover) in the event of manual action by the administrator, network failure, application failure, or when application performance metrics fall outside of preconfigured parameters.

The vCenter Server Heartbeat architecture also allows the passive server to be easily accessed for maintenance purposes such as hardware component replacement, updating anti-virus definition files, receiving operating system hot fixes, updates and patches from third-party management software, and additionally allows use of third-party monitoring tools.

Server Protection

The servers that make up the vCenter Server Heartbeat Pair communicate regularly by sending “I’m alive” messages and message acknowledgments to each other. Through this mechanism, hardware failure scenarios or operating system crashed can be detected. This allows, vCenter Server Heartbeat to provide continuous availability to vCenter Server ensuring users are provided with a replica server in the event of failure of the production server.

Network Protection

vCenter Server Heartbeat continuously monitors the network by periodically polling up to three defined nodes. If all three nodes fail to respond, for example in the case of a network card failure or a local switch failure, vCenter Server Heartbeat can automatically migrate all operations to the Secondary server to prevent interruption of service.

Application Protection

Running on the active server, vCenter Server Heartbeat locally monitors vCenter Server and its services. If the protected application fails, vCenter Server Heartbeat first tries to restart the application on the active server. If restarting the application fails, then vCenter Server Heartbeat can be configured to migrate operations to the Secondary server to prevent service interruption.

Performance Protection

vCenter Server Heartbeat continuously monitors system performance attributes to ensure that the system administrator is notified of problems and can take preemptive action to prevent an outage. Additionally, vCenter Server Heartbeat can monitor specific application attributes to ensure that they remain within normal operating ranges. Various rules can be configured to trigger specific corrective actions whenever these attributes fall outside of their respective ranges.
Data Protection

vCenter Server Heartbeat intercepts all data written by users and applications, and maintains a copy of this data on the passive server which is used in the event of a failure. vCenter Server Heartbeat configures itself to protect files, folders, and even the registry settings for vCenter Server on the active server by replicating these in near real-time to the passive server. If a server fails, all files protected on the failed server are available on the Secondary server after a failover completes.

Communications

vCenter Server Heartbeat Communications

vCenter Server Heartbeat Primary and Secondary servers communicate with one another via the VMware Channel which is used for control and data transfer. Clients connect to vCenter Server and vCenter Server Heartbeat using the Principal (Public) network.

VMware Channel

The VMware Channel is a dedicated communications link for control and data replication between the active and passive servers. The VMware Channel operates independently from the Principal (Public) network that services clients. The VMware Channel consists of a dedicated NIC on each of the two servers configured to communicate with only the other server’s VMware Channel NIC. When required, static routing can be used to direct traffic to the other server. A second pair of NICs is recommended in order to provide a degree of redundancy for the VMware Channel. The NICs on the active and passive servers used for the VMware Channel are normally configured so that their IP addresses are outside of the subnet range of the Principal (Public) network. These addresses are referred to as VMware Channel addresses as illustrated above.

Principal (Public) Network

Users connect to vCenter Server Heartbeat using the Principal (Public) network. For communications with the Principal (Public) network, each server in the Pair must have at least one dedicated NIC on the Primary (active) server and one dedicated NIC on the Secondary (passive) server. The NIC on the passive server is configured to use the same IP address as that of the active server but is prevented from communicating with the live network through an IP packet filtering system installed with vCenter Server Heartbeat. This packet filter prevents traffic using the Principal (Public) address from being committed to the wire. It also prevents NetBIOS traffic utilizing other IP addresses on the NIC from being sent to prevent NetBIOS name resolution conflicts.
Node Configuration

vCenter Server Heartbeat can be configured to support multiple configuration modes such as identical nodes and non-identical nodes with updatable DNS servers but is most commonly configured for non-identical nodes with non-updatable DNS servers (referred herein as non-identical nodes). In this configuration vCenter Server Heartbeat provides enhanced management capabilities by providing continuous access to the passive server simultaneously while the active server continues to vCenter Server. With non-identical nodes, vCenter Server Heartbeat uses unique server names for each server and enhanced IP address management capabilities to accommodate non-updatable DNS servers.

The Secondary server uses a different Fully Qualified Domain Name (FQDN) than the Primary server but uses the same file and data structure, same Principal (Public) network address, and can run the same applications and services as the Primary server. With vCenter Server Heartbeat software symmetrical in almost all respects, either the Primary server or the Secondary server can assume the active role providing availability of vCenter Server to the user.
This chapter discusses the installation of vCenter Server Heartbeat using the most common configuration and provides an overview of the prerequisites for successful installation. It contains the following sections:

**NOTE** For other supported configurations, see the *vCenter Server Heartbeat Installation Guide*.

- “Overview” on page 11
- “Environmental Prerequisites” on page 11
- “Common Requirements” on page 12
- “Server Architecture” on page 13
- “Application Component Options” on page 13
- “Network Requirements” on page 14
- “Installation Process” on page 15
- “Post Installation Configuration” on page 25

**Overview**

vCenter Server Heartbeat is a versatile solution that provides complete protection for vCenter Server and SQL Server. Although vCenter Server Heartbeat can be deployed in multiple configurations, this guide focuses on installation of vCenter Server Heartbeat in the most commonly deployed configuration mode — *non-identical nodes*.

This configuration is supported when installed on Microsoft Windows 2008 Server, in a LAN, with a Virtual to Virtual (V2V) architecture using the Pre-Cloned installation technique and SQL Server installed on the same host as vCenter Server. For other supported configurations, see the *vCenter Server Heartbeat Installation Guide*.

**Environmental Prerequisites**

When installing vCenter Server Heartbeat, ensure that the server selected for installation is not configured as a domain controller, global catalog, or DNS server.

**NOTE** Because vCenter Server Heartbeat protects only vCenter Server and SQL Server applications, other critical business applications should not be installed on the server on the same server.

**FireWall Configuration Requirements**

When firewalls are used to protect networks, you must configure them to allow traffic to pass through both vCenter Server Heartbeat’s Client Connection port (52267) and Default Channel port (57348). VMware recommends that the Client Connection port be configured by process rather than by specific port and that the Default Channel port be configured to allow traffic to pass through on the specific configured port.
Common Requirements

The following requirements are in addition to those required for vCenter Server and SQL Server

- Supported vCenter Server versions

  **NOTE** Although vCenter Server Heartbeat supports vCenter Server versions 2.5 through version 4.1 Update 1, you must use version 4.0 Update 1 or later when configuring with *non-identical nodes*. For other configurations, see *vCenter Server Heartbeat Install Guide*.

  - vCenter Server 4.0 Update 1
  - vCenter Server 4.0 Update 2
  - vCenter Server 4.0 Update 3
  - vCenter Server 4.1
  - vCenter Server 4.1 Update 1

  **NOTE** vCenter Server Heartbeat supports protection of both standalone instances of vCenter Server 4.0.x and also when in Linked Mode groups.

- Operating Systems


  - Windows Server 2008 x86 Standard/Enterprise SP1 and SP2
  - Windows Server 2008 x64 Standard/Enterprise SP1 and SP2
  - Windows Server 2008 R2 Standard/Enterprise

  **NOTE** If .Net 2.0 is not currently installed on the server, vCenter Server Heartbeat Setup installs this required component, taking some additional time during the installation process.

- Prior to installing vCenter Server Heartbeat, verify that vCenter Guided Consolidation, vCenter Update Manager, and vCenter Converter are configured using Fully Qualified Domain Names (FQDN) rather than IP addresses.

- During the setup process, vCenter Server Heartbeat verifies that a minimum of 1GB RAM is available. To ensure proper operation, vCenter Server Heartbeat requires a minimum of 1GB RAM (2GB is recommended) in addition to any other memory requirement for the Operating System or vCenter Server.

- Verify that 2GB of disk space is available on the installation drive for vCenter Server Heartbeat.

- Obtain and use local administrator rights to perform vCenter Server Heartbeat installation.

- Apply the latest Microsoft security updates.

- All applications that will be protected by vCenter Server Heartbeat must be installed and configured on the Primary server prior to installing vCenter Server Heartbeat.

- Verify that both Primary and Secondary servers have identical system date, time, and time zone settings. Once configured, do not change the time zone.

- Verify that the Principal (Public) network adapter is listed as the first network adapter in the network connections bind order. *(Network Connections > Advanced > Advanced Settings)*.

- Verify that the Managed IP setting in the vSphere Infrastructure Client is the same IP address used for the vCenter Server Heartbeat Principal (Public) IP address.
**Server Architecture**

Virtual to Virtual (V2V) is the supported architecture when vCenter Server is already installed on the production (Primary) server running on a virtual machine. VMware vCenter virtual machine is used for creating a cloned image of the Primary server (Pre-Clone) for use as a Secondary server. The Secondary virtual machine must meet the following minimum requirements.

- Similar CPU (including resource management settings)
- Memory configuration (including resource management settings)
- Appropriate resource pool priorities
- Operating System version and Service Pack
- Each virtual machine used in the V2V pair must be on a separate ESX host to guard against failure at the host level.
- Each virtual NIC must use a separate virtual switch.

**Application Component Options**

vCenter Server Heartbeat provides protection for the following components:

- **vCenter Server Version 4.0**
  - VMware vCenter Server
  - VMware Guided Consolidation Service
  - VMware License Sever
  - VMware ADAM
  - VMware vCenter Management Web Server
  - VMware vCenter Update Manager
  - VMware vCenter Converter
  - VMware vCenter Orchestrator
  - VMware vSphere Host Update Utility
  - VMware vSphere Client

- **vCenter Server Version 4.1**
  - VMware vCenter Server
  - VMware Guided Consolidation Service
  - VMware License Sever
  - VMware ADAM
  - VMware vCenter Management Web Server
  - VMware vCenter Update Manager
  - VMware vCenter Converter
  - VMware vCenter Orchestrator
  - VMware vSphere Host Update Utility
  - VMware vSphere Client

- **VMware View Composer 1.1 and 2.0**
  - VMware View Composer
  - VMware Universal File Access

- **vCenter Converter Enterprise**

- **SQL Server Versions**
  - Microsoft SQL Server 2005 SP1-SP3
  - Microsoft SQL Server 2008 including SP2
vCenter Server with SQL Server on the Same Host

To ensure adequate performance in 20+ host or 200+ virtual machine environments, VMware recommends that SQL Server and vCenter Server be installed on separate physical disk drives. VMDKs must be on separate datastores to avoid potential disk bottlenecks.

vCenter Server with SQL Server on a Separate Host

When installing vCenter Server Heartbeat in an environment where SQL Server is on a separate host from vCenter Server, repeat the installation process for the Primary and Secondary server specifically for the SQL Server.

Network Requirements

When deployed in a LAN environment, vCenter Server Heartbeat requires that both servers use the same Principal (Public) IP address. Each server also requires a separate VMware Channel IP address on a separate dedicated subnet.

NOTE vCenter Server Heartbeat can be configured to support teamed NICs but requires additional configuration steps. See Knowledge Base article 1027288 for more information about teamed NICs.

Primary Server

Three NICs (1 x Principal (Public); 2 x VMware Channel) are recommended for redundancy in the event one VMware channel fails. A minimum of two NICs (one for the Principal (Public) connection, and one for the VMware Channel) are required in this configuration.

- Principal (Public) Network connection configured with the following:
  - Static IP address
  - Correct network mask
  - Correct Gateway address
  - Correct preferred and secondary (if applicable) DNS server address
  - NetBIOS enabled

- VMware Channel network connection(s) configured with the following:
  - Static IP address in a different subnet than the Principal (Public) network with a different IP address than the Secondary server VMware Channel NIC
  - Correct network mask
  - No Gateway IP address
  - No DNS server address
  - NetBIOS enabled (disabled during the installation process)

Secondary Server

Networking components on the Secondary server must be configured as follows:

- Same number of NICs as the Primary server
- Principal (Public) network connection configured with temporary network settings
- VMware Channel network connection(s) configured with the following:

NOTE Ensure that all VMware components are bound to the Principal (Public) IP address on the Principal (Public) network adapter and that the Principal (Public) network adapter is listed first in the bind order of the Network Connections > Advanced > Advanced Settings window.
Static IP address in a different subnet than the Principal (Public) network with a different IP address than the Primary server VMware Channel NIC

Correct network mask

No Gateway IP address

No DNS IP address

NetBIOS enabled (disabled during the installation process)

File and print sharing enabled

### Installation Process

vCenter Server Heartbeat is installed on both the Primary and Secondary server of a vCenter Server Heartbeat Pair. VMware recommends that you use the Pre-Installation Checklist to ensure all prerequisites have been met.

**NOTE** When protecting SQL Server, the SQL Server instance service must run under an account with administrator rights rather than the Network Service or Local System account. If required, change the Log On AS property by navigating to Start > Administrative Tools > Services. Select the SQL Service instance and click Properties. Select the Log On tab and select This account. Provide the new account credentials and click OK. Once complete, restart the SQL Server instance service.

### Primary Server

Installation of vCenter Server Heartbeat begins on the Primary server and uses a multi-step process to configure the installation.

**To install vCenter Server Heartbeat on the Primary server**

**NOTE** vCenter Server Heartbeat prompts you to enter a valid serial number during the installation process. If you do not enter a valid serial number during the installation process, vCenter Server Heartbeat installs in evaluation mode.

1. Having verified all of the environmental prerequisites are met, download the vCenter Server Heartbeat self-extracting file to an appropriate location on the Primary server.

2. Open Network Connections, right-click the VMware Channel network connection and select Properties. Select Internet Protocol (TCP/IP) and click Properties.

3. Click Advanced, select the DNS tab, and clear the Register this connection’s addresses in DNS check box. Click OK three times to close the dialogs.

4. Right-click the Principal (Public) network connection and select Properties. Select Internet Protocol (TCP/IP) and click Properties.

5. Click Advanced, select the DNS tab, and clear the Register this connection’s addresses in DNS check box. Click OK three times to close the dialogs.

6. Clone the Primary server using VMware vCenter virtual machine cloning or another third-party utility to create a cloned image of the Primary server. The clone must be completely identical with no changes to the Name, SID, or domain membership. Do not start the cloned server.

7. Double-click the self-Extracting file to initiate the installation process on the Primary server. The Setup Introduction dialog appears. Review the information and click OK.

**NOTE** If you click Exit after Setup has started, you are prompted to save your settings. When you run Setup.exe later, you will be asked if you want to use the previously saved configuration.

8. The Self-Extractor dialog appears. Click Setup to continue.
9 The **Setup Type** page appears. Because this is a new installation of vCenter Server Heartbeat, select **Install vCenter Server Heartbeat** and click **Next**.

**NOTE** The left pane of each page in the setup wizard provides information about the setup process.

10 Select the physical identity of the server on the **Physical Hardware Identity** page. Select **Primary** as the server identity and click **Next**.

11 Read the license agreement carefully and select **I accept terms of the License Agreement**. Click **Next**.

12 Click **Add** to enter a valid serial number for production mode or click **Next** to install in the evaluation mode.

13 Select **LAN** for the network topology and in the **Deploy Heartbeat Cluster across** pane, select **Non-identical** since you are using a non-updatable DNS server. Click **Next**.

14 The **Pre-Clone** option uses the VMware vCenter virtual machine cloning to create a clone of the Primary server in a V2V architecture while the Install Clone option is used for a P2V or P2P architecture. Select the **Pre-Clone** option and click **Next**.

15 Configure the installation paths. The default installation location is `C:\Program Files\VMware\vCenter Server Heartbeat`, but you can change it by manually typing a path to another install location. Alternatively, click **Browse** to select a different location. Select **Create icons on Desktop** and click **Next**.

**NOTE** The path of the VMware installation folder cannot contain Unicode characters. If vCenter Server Heartbeat is installed in a folder that has a path containing Unicode characters, this causes the Neverfail Server R2 service to fail to start. The path of the VMware installation folder can only contain lower and upper case letters A to Z, digits from 0 to 9, and the following special characters: space `\ _ - ( ) .:`

Additionally, vCenter Server Heartbeat does not support file or folder names ending with a period `"."` or space `" "`.

16 Identify the network adapter(s) for use in the VMware Channel on the **Channel Adapter Identification** page. Select the network adapters (NICs) for the VMware Channel from the list. Click the adapter name to display the selected NIC properties in the lower pane. You must select at least one NIC to proceed with the installation.
If no NICs are available, click **Open Network Connections** to review the network configuration of your machine and verify that you have the correct number of NICs installed. After selecting the appropriate NIC, click **Next**.

**NOTE** Only one channel can be configured for each NIC. To configure more than one VMware Channel you must identify more than one NIC. A disabled NIC does not appear in this list. Enable the NIC to display it. If a NIC is disconnected, its IP addresses do not appear in the lower pane.

17 The **VMware Channel IP Configuration** page prompts you to configure the VMware Channel(s) IP network addresses. Click **Add** for each available VMware Channel connection. For the Primary server, select from a drop-down menu that lists all local IP addresses. Type the reciprocal IP address on the Secondary server into the **IP Address On Secondary** text box. You must specify all VMware Channel IP addresses in subnets outside of the normal Principal (Public) IP addressing schema so that VMware Channel traffic routing uses the VMware Channel network card rather than the Principal (Public) network card. Click **OK**. Repeat this step for additional NICs.

18 Review and adjust, if necessary, the default channel port. Click **Next**.

19 Select the Principal (Public) NIC(s). The IP address information is displayed for each NIC. Click **Next**.

**NOTE** Adjacent IP addresses should be reserved and used for the Principal (Public) IP address and the Management IP addresses for the Primary and Secondary Servers when installing vCenter Server Heartbeat on non-identical nodes on servers running Windows 2008.

20 Select **Use same IP addresses for Secondary** (Recommended for HA secondary) and click **Add** to specify the IP address.

21 Add the Principal (Public) network address. Click **Next**.

22 The vCenter Server Heartbeat server pair can be administered remotely on client machines using the vCenter Server Heartbeat Console. The vCenter Server Heartbeat Console connects to an IP address of the active server using the default Client Connection port of 52267. If this port is already in use, type an available Client Connection port in the text box. Click **Next**.

23 Select the applications to protect. All licensed vCenter Server Heartbeat features are listed.

- If installing vCenter Server locally and the SQL Server on a separate server, select **Protect Virtual Center only**.
If installing SQL Server remotely, upon completion of the vCenter Server installation locally, repeat the installation procedure at the remote SQL Server location and select **Protect SQL Server only**.

If installing both vCenter Server and SQL Server locally, select **Protect Virtual Center and SQL Server**.

24 The **Microsoft Windows Backup Configuration** page prompts you to select options to facilitate the clone of the Primary server onto the Secondary server. The cloning process requires pertinent components of the Primary server for restoration on to the Secondary server. With the Pre-Clone technique selected, Setup backs up two small files, `nfsetup.dat` and `primary.csv`, from the Primary server and restores them to the Secondary server for proper configuration.

25 Select a location to place the backup files through the **Microsoft Windows Backup Configuration** page. When installing into a Windows Server 2008 environment, you must specify a UNC path to the backup file location. Type a UNC path to a location using the machine name or IP address and shared folder into the **Folder** text box, for example: `\10.0.0.16\Backup`. Type a **User** and **Password** that grants access to the shared folder. Click **Next**.

26 vCenter Server Heartbeat takes the backup using the Windows Volume Shadow Service and does not stop services, thereby preventing downtime. Click **Next**.

27 Review the summary of options and configuration information for the installation. Click **Next**.

28 Pre-install checks run to verify that the options selected are compatible with the current configuration. Setup checks the available disk space, system memory, operating system compatibility, and dependencies between modules.

**NOTE** The **Progress** pane on the **Pre-Install Checks** page displays the progress of these checks. When finished, the **Report** pane displays the results.

29 If some pre-install checks are unsuccessful, click the **Back** button to go back through the wizard, make the necessary changes, and run the pre-install checks again. If the pre-install checks are successful, click **Next**.

30 The next page displays the progress of the installation. During this process, Setup installs the necessary files and folders onto your system and applies the configuration you specified. Setup also installs Heartbeat Diagnostics and configures it with the default settings. Once complete, click **Next**.

31 The vCenter Server Heartbeat Packet Filter driver installs on each network card of the production server. If you see warnings that the driver is unsigned or did not complete the Windows Logo tests, click **Install**. If Windows is configured to display Signed Driver warnings, you may see multiple warnings. The **Report** pane displays the results. Click **Next**.

By default, the vCenter Server Heartbeat Packet Filter driver is bound to all Principal (Public) network cards present on the machine. The vCenter Server Heartbeat Packet Filter is not bound to the network cards forming VMware Channel connections as these cards maintain unique IP addresses irrespective of the role of the server. vCenter Server Heartbeat also disables NetBIOS on the VMware Channel NIC(s) to prevent domain name conflicts on the subnet.

32 When the Setup wizard confirms the successful completion of the installation, click **Finish**.

33 The Configure Server wizard is launched and allows you to configure the Primary server for use with **non-identical nodes**.

34 Click the **Public** tab and select **Non-Identical** (for non-updatable DNS servers).

35 Enter the **Service Name** for the vCenter Server or SQL Server.

**NOTE** The **Service Name** is the DNS name by which application clients connect to the application. Normally this is the original name of the vCenter Server or SQL Server. There is only one **Service Name** and it is the same on all servers in the cluster.

36 In the **NIC** drop-down, select the Principal (Public) NIC.

37 In the **Public IP** drop-down, select the Principal (Public) IP address assigned to the Principal (Public) NIC.
38 In the first **Mask** field, enter the Subnet Mask of the Principal (Public) IP address.

39 In the **Passive IP** field, enter a reserved Management IP address for the Primary server.

**NOTE** The Management IP address is unique for each server in the cluster.

40 In the second **Mask** field, enter the Subnet Mask of the Management IP address.

41 Verify that the option to Start vCenter Server Heartbeat is not selected and Click **Finish**.

**Secondary Server**

The process of installing vCenter Server Heartbeat on the Secondary server is similar to installing vCenter Server Heartbeat on the Primary server.

**To install vCenter Server Heartbeat on the Secondary server**

1 Before powering on the Secondary server image, edit the image settings.
   a Select the Principal (Public) virtual network adapter and clear the **Connected** and **Connect at power on** check boxes.
   b Repeat the process on the VMware Channel virtual network adapter.
   c Power on the Secondary server image.
   d After the Secondary server starts, open **Network Connections**, right-click the VMware Channel network connection, and select **Properties**. Select **Internet Protocol (TCP/IP)** and click **Properties**.
   e Configure the appropriate VMware Channel IP address and Subnet Mask. Click **Advanced**
   f Click the **WINS** tab, select **Disable NetBIOS over TCP/IP** and Click **OK** three times to close the dialogs.
   g Right-click the Principal (Public) network connection and select **Properties**. Select **Internet Protocol (TCP/IP)** and click **Properties**. Configure the Principal (Public) IP address (same as the Primary server), Subnet Mask, and Default Gateway.
   h Click **OK** three times to close the dialogs.
   i Right-click the Secondary server image and select **Edit Settings**.
   j Select the VMware Channel virtual network adapter and select the **Connected** and **Connect at power on** check boxes. IP communications with the Secondary server go through the VMware Channel.

**NOTE** Do not connect the Principal (Public) virtual network adapter at this time to prevent an IP address conflict on the network.

2 To install the vCenter Server Heartbeat on the Secondary server, execute the self-extracting file to start the installation process. The **Setup Introduction** dialog appears. Review the information and click **OK**.

**NOTE** If you click **Exit** after Setup has started, you are prompted to save your settings. When you run the self-extracting file again later, you will be asked if you want to use the previously saved configuration.

3 The **Self-Extractor** dialog appears. Click **Setup** to continue.

4 The **Setup Type** page appears. As with the installation on the Primary server, select **Install VMware vCenter Server Heartbeat** and click **Next**.

**NOTE** The left pane of each page in the setup wizard provides information about the setup process.

5 Select the identity of the server on the **Physical Hardware Identity** page. Select **Secondary** as the server identity and click **Next**.
6 Identify the location of the folder containing the backup file from the Primary server. Manually type the location path in the text box. Click **Next**.

**NOTE** On Windows Server 2008 installations, you must use the UNC path.

7 The pre-install checks run. Click **Next**.

**NOTE** The pre-install checks will return the message that the Primary and Secondary server’s names match. This is expected and installation will be allowed to continue.

If some pre-install checks are unsuccessful, click the **Back** button to go back through the wizard, make the necessary changes, and run the pre-install checks again.

8 The next page displays the progress of the installation. During this process, Setup installs the necessary files and folders onto your system and applies the configuration you specified. Setup also installs Heartbeat Diagnostics and configures it with the default settings.

9 The **Report** pane displays the results of the installation. Click **Next**.

10 The progress of the VMware vCenter Server Heartbeat Packet Filter installation is displayed. Click **Next**.

11 The Packet Filter is installed on the Principal (Public) NIC. Once complete, the Principal (Public) network adapter can be reconnected. Right-click the Secondary server image name and select **Edit Settings**.

12 Select the Principal (Public) virtual network adapter, select the **Connected** and **Connect at power on** check boxes, and click **OK**.

13 In the **Channel Adapter Identification** page, select the appropriate adapter and review the IP address configuration in the lower pane. Click **Next**.

14 Although you previously configured the IP address of the Principal (Public) network connections, you can make any last minute changes on the Secondary server through vCenter Server Heartbeat. Click **Next**.

15 The **Duplicate Installation Complete** page is displayed. Do not select the **Start vCenter Server Heartbeat** check box. Click **Finish**.

16 The Configure Server wizard is launched and allows you to configure the Secondary server for use with **non-identical nodes**.

17 Click the **Public** tab and select **Non-Identical** (non-updatable DNS servers).
18 Enter the **Service Name** for the vCenter Server or SQL Server.

**NOTE** The **Service Name** is the DNS name by which application clients connect to the application. Normally this is the original name of the vCenter Server or SQL Server. There is only one **Service Name** and it is the same on all servers in the cluster.

19 In the **NIC** drop-down, select the Principal (Public) NIC.

20 In the **Public IP** drop-down, select the Principal (Public) IP address assigned to the Principal (Public) NIC.

21 In the first **Mask** field, enter the Subnet Mask of the Principal (Public) IP address.

22 In the **Passive IP** field, enter a reserved Management IP address for the Secondary server.

**NOTE** The Management IP address is unique for each server in the cluster.

23 In the second **Mask** field, enter the Subnet Mask of the Management IP address.

24 Click **Finish**. Do not start vCenter Server Heartbeat.

25 Verify that the pre-populated management names and IP addresses to be used are configured and available in the non-updatable DNS servers before starting vCenter Server Heartbeat for the first time.

### Renaming the Servers

Configuration for **non-identical nodes** in the Pair requires unique server names for each server and the vCenter Server application to operate properly. To create the unique names you must rename both the Primary and Secondary servers to ensure proper configuration and prevent name resolution problems when clients attempt to access the vCenter Server application.

For example, before installing vCenter Server Heartbeat your vCenter Server is named “vCenterServer”. During the vCenter Server Heartbeat installation process on “vCenter Server” you clone “vCenterServer” (the Primary server) to create a Secondary server.
After installation you rename the Secondary server to “vCSHB-Secondary” and then rename the Primary server to “vCSHB-Primary”. You then use the Configure Server Wizard and identify the Service Name as “vCenterServer” thereby allowing access to vCenter Server on either the Primary or Secondary servers.

To rename the Secondary server

1. Navigate to Start > Administrative Tools > Services and set the Neverfail Server R2 service to Manual, Stopped, and close the dialog.
2. Right-click the Secondary server image and select Edit Settings.
3. Disable the virtual network adapters for both the VMware Channel and Principal (Public) NICs.
4. Open Network Connections, right-click the Principal (Public) network connection and select Properties. Select Internet Protocol (TCP/IP) and click Properties.
5. Change the IP address to the match that of the Secondary management IP address previously entered in the Configure Server wizard. Click OK twice to close the dialogs.
6. Navigate to the server’s System Properties, select the Computer Name tab, and click Change to rename the Secondary server and join a Workgroup. When requested, restart the server.
7. Right-click the Secondary server image and select Edit Settings.
8. Re-enable the virtual network adapters for both the VMware Channel and Principal (Public) NICs.
9. Navigate to the server’s System Properties, select the Computer Name tab, and click Change to join the domain. When requested, restart the server.

To rename the Primary Server

1. Navigate to Start > Administrative Tools > Services and set the Neverfail Server R2 service to Manual, Stopped, and close the dialog.
2. Navigate to the server’s System Properties, select the Computer Name tab, and click Change to rename the Primary server. When requested, restart the server.

Post Installation

On both the Primary and Secondary servers, navigate to Start > Administrative Tools > Services and set the Neverfail Server R2 service to Automatic, and close the dialog. See “Post Installation Configuration” on page 25.

NOTE  If vCenter Server Heartbeat was installed in an environment where SQL Server is on a separate host from vCenter Server, repeat the installation process for the Primary and Secondary server specifically for the SQL Server.

vCenter Server Heartbeat Console

vCenter Server Heartbeat can be managed via the vCenter Server Heartbeat Console installed on the Primary or Secondary server during the installation process. It can also be managed remotely on a workstation running Microsoft Windows XP, Vista, or Windows 7 via the vCenter Server Heartbeat Console installed using vCenter Server Heartbeat Client Tools.

Installation of Client Tools

vCenter Server Heartbeat allows installation of vCenter Server Heartbeat Client Tools for remote management of vCenter Server Heartbeat Pair.

NOTE  When installing vCenter Server Heartbeat Client Tools on Windows XP, the following Service Pack levels are required.

- Windows XP 32 bit SP3
- Windows XP 64 bit SP2
**To install vCenter Server Heartbeat Client Tools**

1. Copy the self-extracting file to the client where it is to be installed.
2. Double-click the self-extracting file to initiate the installation process. The Setup Introduction dialog appears. Review the information and click OK.
3. The Self-Extractor dialog appears. Click Setup to continue.
4. The Setup Type page appears. Because this is a vCenter Server Heartbeat Client Tools installation, select Install Client Tools Only and click Next.
5. Read the license agreement carefully and select I accept terms of the License Agreement. Click Next.
6. Configure the installation paths. The default installation location is C:\Program Files\VMware\VMware vCenter Server Heartbeat, but you can change it by manually typing a path to another install location. Alternatively, click Browse to select one of these locations. Select Create icons on Desktop and click Next.
7. Review the summary of options and configuration information for the installation. Click Next.
8. Pre-install checks run to ensure the options selected are compatible with the environment. The Report pane displays the results of the pre-install checks. If some pre-install checks are unsuccessful, click Back to go back through the wizard, make the necessary changes, and run the pre-install checks again. If the pre-install checks are successful, click Next.
9. The next page displays the progress of the installation. During this process, Setup installs the necessary files and folders onto your system and applies the configuration you specified. Click Next after vCenter Server Heartbeat Client Tools components are complete.
10. The Client Tools Installation Complete page is displayed. Click Finish.

**Administering vCenter Server Heartbeat**

To administer a pair of servers you must connect to them through the vCenter Server Heartbeat Console. vCenter Server Heartbeat Console does not connect until vCenter Server Heartbeat initializes.

You can start vCenter Server Heartbeat Console from any server in the vCenter Server Heartbeat Pair.

**To start vCenter Server Heartbeat Console**

1. Right-click the VMware vCenter Server Heartbeat interactive status icon on the Windows too tray. Select Manage Server. The vCenter Server Heartbeat Console opens in a window and shows the Heartbeat Servers (overview) pane.

   **NOTE** Alternatively you can start vCenter Server Heartbeat Console from the VMware program group on the Windows Start menu. This is the only method supported if vCenter Server Heartbeat Console has been installed on a workstation that is not part of the Pair (using vCenter Server Heartbeat Client Tools).

**Navigate vCenter Server Heartbeat Console**

After vCenter Server Heartbeat Console is running, use the navigation panel on the left of the vCenter Server Heartbeat Console window to view and select Groups and Pair connections you can manage with vCenter Server Heartbeat Console. A group is an arbitrary collection of vCenter Server Heartbeat Pairs used for organization while a Connection or Pair Connection allows vCenter Server Heartbeat Console to communicate with a vCenter Server Heartbeat Pair either on the same machine or remotely.
The selection of Group or Pair you make in the navigation panel “points” the vCenter Server Heartbeat Console to that Group or Pair and vCenter Server Heartbeat Console provides information related to only the selected Group or Pair. To avoid confusion, pay particular attention to the selection in the navigation panel when you are managing more than one Group or Pair.

**NOTE** Groups and Pairs are not automatically detected by vCenter Server Heartbeat Console. Each Group or Pair you want to manage must be added to vCenter Server Heartbeat Console before you can use it to view status or change settings for that Group or Pair Connection.

---

### Add a vCenter Server Group

The Add Group feature in vCenter Server Heartbeat Console allows you to add new vCenter Server Heartbeat Groups to manage.

**To add a vCenter Server Heartbeat Group**

1. Open vCenter Server Heartbeat Console and select *Add Group* from the *File* menu.
2. Type the name for the new group into the text box and click *OK*. The newly created group appears in the navigation panel on the left of the vCenter Server Center Heartbeat window.

---

### Add a New Connection

The Add Connection feature in the vCenter Server Heartbeat Console allows you to add a new Pair Connection to an existing vCenter Server Heartbeat Group.

**NOTE** When a you attempt to connect to vCenter Server Heartbeat for the first time, you are presented the option to accept the SSL certificate from the server. To continue connecting to vCenter Server Heartbeat, you must accept the SSL certificate from vCenter Server Heartbeat.

**To Add a new connection**

1. In the navigation panel, select the vCenter Server Heartbeat Group to receive the new connection. Select *Add Connection* from the *File* menu to invoke the *Add Connection* dialog.
2. Type the Host Name or IP address for the new connection into the text box, select the Port Number (if different from the default value of 52267), and select a group from the *Add to Group* drop-down list (to add the connection to a Group other than the one currently selected).
3. Click *OK*. The newly created connection appears in the navigation panel on the left of the vCenter Server Heartbeat Console window, and the *Server: Summary* page updates to represent any existing network relationships of the added server.
   
   **NOTE** You may be prompted to login. If so, login using a valid administrator-level Username and Password for the server for which you are adding a connection, and click *OK*.

4. Enter the remaining connections necessary to define the new vCenter Server Heartbeat Group.
5. Select a Pair in the navigation panel of vCenter Server Heartbeat to show a set of tabs and sub-tabs that offer detailed status and control of the associated vCenter Server Heartbeat servers in the Pair.
Post Installation Configuration

Upon completion of installation, a series of tasks must be performed to ensure that vCenter Server Heartbeat is properly configured.

1. Verify that the SetSPN.exe (Service Principal Names) executable is present in the Windows\System32 directory on both the Primary and Secondary servers (this is normally present as a component of the Windows 2008 operating system).

SetSPN.exe is a Microsoft command-line tool that reads, modifies, or deletes the Service Principal Names (SPN) directory property for an Active Directory service account and is required to be present on both servers prior to starting vCenter Server Heartbeat for the first time.

2. Start vCenter Server Heartbeat on the Primary server. Right-click the vCenter Server Heartbeat System Tray icon and select Start VMware vCenter Server Heartbeat. The icons change from a double dash (–/–) to a P, indicating the server is the Primary server, and an A indicating the server is acting in an active role (P/A).

3. Start vCenter Server Heartbeat on the Secondary server. Right-click the vCenter Server Heartbeat System Tray icon and select Start VMware vCenter Server Heartbeat. The icon changes from a double dash (–/–) to an S, indicating that the server is the Secondary server, and a dash (–), indicating that the server is in a passive role (S/–).

The Primary and Secondary servers establish a handshake and commence replication.

4. Verify that Nslookup resolves as shown below:
   - Nslookup resolves the Service Name to the Public IP
   - Nslookup resolves the Primary Name to the Public IP
   - Nslookup resolves the Secondary Name to the Secondary Passive IP

If SQL Server is to be installed on a separate host from vCenter Server, repeat the installation process for the Primary and Secondary servers at the remote site and select SQL Server only. See go to “Primary Server” on page 14.

Configuring VirtualCenter Plug-in with the Correct Credentials

After installation is complete, you must enter the credentials for an account with rights to the vSphere Infrastructure.

To add the vSphere Infrastructure credentials

1. Navigate to the Applications: Plug-ins page.
2. Select the VirtualCenterNFPlugin.dll
3. Click Edit.
4. Type the Username and Password for an account with rights to the vSphere Infrastructure.
5. Click OK.

Configuring SQL Server Plug-in to run with the Correct Credentials

After installation, you must configure the SQL Server Plug-in with the correct credentials.

To add the SQL Server Plug-in credentials

1. Launch the vCenter Server Heartbeat Console and navigate to the Applications: Tasks page.
2. Click User Accounts. Verify that the user account under which you installed vCenter Server Heartbeat is present in the list of User Accounts. If it is present and is a member of the Domain Admins group, Enterprise Admins group, or has been delegated Administrator rights, go to Step 6.
3. In the User Accounts dialog, click Add.
4 Enter the credentials of a domain account that is a member of the Domain Admins group, Enterprise Admins group, or one that has been delegated Administrator rights and click **OK**.

5 Once the account has been successfully added to the list, click **Close**.

6 In the **Tasks** pane, select the Network Configuration task **Set SPN (Primary)**.

7 Click **Edit**.

8 In the **Edit Task** dialog, in the **Run As** drop-down field, select an account with appropriate rights (the account previously added).

9 Click **OK**.

10 In the **Tasks** pane, select the Network Configuration task **Set SPN (Secondary)**.

11 Click **Edit**.

12 In the **Edit Task** dialog, in the **Run As** drop-down field, select an account with appropriate rights (the account previously added).

13 Click **OK**.

14 After successfully configuring the correct credentials, select the **Set SPN (Primary)** task and click **Run Now**.

### Installing the View Composer Plug-in

After installation you must install the View Composer Plug-in.

**To install the View Composer Plug-in after vCenter Server Heartbeat has been installed**

1 Ensure that View Composer has been installed on both the Primary and Secondary servers with the same configuration settings.

2 Launch the vCenter Server Heartbeat Console.

3 Navigate to **Applications: Plug-ins** and click **Install**.

4 Browse to the plug-in file located at:
   `<unzipped_folder>\vCenterServerHeartbeatVersion-x86/x64\plugins\ViewComposer\ViewComposerNFPlugin.dll`.

5 Click **OK** to install the View Composer Plug-in.

6 View the **Plugins** pane to verify that **ViewComposerNFPlugin.dll** is present and was successfully installed

### vCenter Server with SQL Server on a Separate Host

When vCenter Server Heartbeat is installed in an environment where SQL Server is on a separate host from vCenter Server, increase the default Heartbeat interval for the vCenter Server from 20 to 30 seconds to ensure proper failover.
This chapter includes the following topics:
- “Verifying vCenter Server Heartbeat” on page 27
- “Failover Simulation” on page 27
- “Data Replication Exercise” on page 28
- “Switchover Exercise” on page 29

Verifying vCenter Server Heartbeat

The Installation Verification process validates the proper installation of vCenter Server Heartbeat and tests the software’s operation.

The following procedures safely exercise the ability of vCenter Server Heartbeat to perform a failover, switchover, and to replicate data and allow you to verify the operations complete successfully without risk to data. These exercises build upon one another and therefore must be performed in order.

VMware does not recommend attempting to test a failover in a production environment on an operating server pair using methods such as unplugging a power cord. When power is lost, any data not written to the passive server can be lost. VMware recommends performing a switchover rather than a failover to test the operation of the passive server.

Failover Simulation

This exercise demonstrates that the Secondary server can function as the Primary Server without the test data being immediately replicated back to the original server. During the exercise, you will stop the Primary server from providing service and hide it from the network, then introduce the Secondary server to the network and allow it to provide service.

Starting Conditions

Using the System Tray icon, verify that the Primary server displays P/A indicating that it is the active server. On the Secondary server, repeat the process and verify that the Secondary server displays S/— indicating that it is passive.

Using the vCenter Server Heartbeat Console, navigate to the Data: Replication tab. Verify that both the File System and the Registry Status display as Synchronized.

Notify any local users that the service will be unavailable for the duration of the exercise.
Actions

Table 3-1. Failover Simulation Exercise Actions

<table>
<thead>
<tr>
<th>Machine</th>
<th>Activity</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary</td>
<td>Right-click on the System Tray icon and select <strong>Shutdown VMware vCenter Server Heartbeat</strong>. Select the option to Stop all protected applications.</td>
<td>vCenter Server Heartbeat stops all monitored services and exits. This can be verified by navigating to the Service Control Manager and viewing the status of the protected services.</td>
</tr>
<tr>
<td></td>
<td>Right-click on the System Tray icon and select <strong>Shutdown VMware vCenter Server Heartbeat</strong>. Select the option to Stop all protected applications.</td>
<td>Primary server becomes passive.</td>
</tr>
<tr>
<td></td>
<td>Right-click on the System Tray icon and select <strong>Start VMware vCenter Server Heartbeat</strong>. Once vCenter Server Heartbeat has started, right-click on the System Tray icon and select <strong>Shutdown VMware vCenter Server Heartbeat</strong>. Select the option to Stop all protected applications.</td>
<td>This activates the network packet filter hiding the Primary server from the network. This can be verified by navigating to the Service Control Manager and viewing the status of the protected services.</td>
</tr>
<tr>
<td>Secondary</td>
<td>Navigate to <strong>Start &gt; All Programs &gt; VMware &gt; VMware vCenter Server Heartbeat &gt; Configure Server</strong> to launch the Configure Server wizard. Select the Machine tab and in the <strong>Active Server</strong> pane, select Secondary server to make the Secondary server’s role active. Right-click on the System Tray icon and select <strong>Start VMware vCenter Server Heartbeat</strong>.</td>
<td>The Secondary server starts as the active server. The System Tray icon displays as S/A.</td>
</tr>
<tr>
<td>Client</td>
<td>Compare the application functional status to the predefined criteria for availability and performance.</td>
<td>Secondary server behaves as the Primary server.</td>
</tr>
</tbody>
</table>

Results

The Secondary server assumed the role of the active server providing the same functionality that the Primary server did previously. This exercise demonstrated that as a result of a failover, the passive server assumes the active role continuing to provide the same level of functionality provided by the Primary server before the failover.

Data Replication Exercise

The Data Replication exercise follows the Failover Simulation exercise performed previously. The objective is to take a working active server (the Secondary server) and synchronize it with the passive (Primary server). This exercise also demonstrates that all the correct services stopped when the Primary server became passive.

Starting Conditions

vCenter Server Heartbeat is running on the Secondary active server. Using the System Tray icon, verify that the server status displays S/A. vCenter Server Heartbeat is not running on the Primary server which is set to passive. Using the System Tray icon, verify that the server status displays —/— to indicate that vCenter Server Heartbeat is not running.

Notify any local users that the service will be unavailable for the duration of the exercise.
Actions

**Table 3-2. Data Replication Exercise Actions**

<table>
<thead>
<tr>
<th>Machine</th>
<th>Activity</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary</td>
<td>Right-click on the System Tray icon and select <strong>Start VMware vCenter Server Heartbeat.</strong></td>
<td>vCenter Server Heartbeat starts. Launch the vCenter Server Heartbeat Console. Select the <strong>Server: Summary</strong> tab to show the connection from the Secondary (active) to Primary (passive).</td>
</tr>
<tr>
<td>Secondary</td>
<td></td>
<td>Data replication resumes from the Secondary server back to the Primary server. Both the <strong>File System &amp; Registry</strong> status become <strong>Synchronized.</strong></td>
</tr>
</tbody>
</table>

Select the **Data: Replication** tab and wait for both the **File System** and the **Registry** status to display **Synchronized.** Access the vCenter Server Heartbeat logs and confirm that no exception errors occurred during the synchronization process.

Results

Both machines become resynchronized. All the data changed on the Secondary machine while vCenter Server Heartbeat was not running on the Primary server has been updated onto the Primary machine and the Secondary (active) machine continues to provide service. This exercise demonstrated that data changes occurring on the Secondary server while vCenter Server Heartbeat was not running on the Primary server are successfully replicated to the Primary server when vCenter Server Heartbeat is restarted on the Primary server.

Switchover Exercise

This exercise demonstrates the ability to switch the functionality and operations of the active server on command to the other server in the pair using the vCenter Server Heartbeat Console. Perform this exercise only after successfully completing the Failover Simulation and Data Replication Exercises.

Notify any local users that the service will be unavailable for the duration of the exercise.

Starting Conditions

Using the System Tray icon, verify that the Secondary server is active (S/A) and servicing clients. On the Primary server, verify that the server is passive using the System Tray icon status (P/—). On the Secondary server, launch the vCenter Server Heartbeat Console and select the **Data: Replication** tab. Verify that both the **File System** and **Registry** status are **Synchronized.**

Actions

**Table 3-3. Switchover Exercise Actions**

<table>
<thead>
<tr>
<th>Machine</th>
<th>Activity</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>vCenter Server Heartbeat Console</td>
<td>Click on the <strong>Server: Summary</strong> tab. Select the Primary server icon and click Make Active.</td>
<td>The vCenter Server Heartbeat Console <strong>Server: Summary</strong> page displays the applications stopping on the active server. Once all applications are stopped, the active server becomes passive and the passive server becomes active. The Console shows the applications starting on the newly active server. Both the <strong>File System</strong> and <strong>Registry</strong> status are <strong>Synchronized.</strong></td>
</tr>
</tbody>
</table>

Any | Confirm application performance and availability meets previously defined criteria. Verify that client applications are running as expected after the switchover process. | Services continue to be provided as before the switchover occurred. You may need to refresh or restart some client applications as a result of a switchover. |
Results

Application service was transferred from the originally active machine to the originally passive machine. This exercise demonstrated that functionality and operations can be switched to the other server in the pair on command while maintaining service to users. It is a best practice to document the application-client behavior upon switchover for future reference.
## Appendix – Pre-Installation Checklist

**Table A-1. Pre-Installation Checklist**

<table>
<thead>
<tr>
<th>Checked</th>
<th>Description of Items to be Checked</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Verify that the server is not configured as a domain controller, global catalog sever, or DNS server.</td>
</tr>
<tr>
<td></td>
<td>Verify that there are no other business critical applications running on the server.</td>
</tr>
<tr>
<td></td>
<td>Verify that the Operating System is Windows 2008 or later.</td>
</tr>
<tr>
<td></td>
<td>Verify that vCenter Server 4.0 Update 1 or later is installed.</td>
</tr>
<tr>
<td></td>
<td>Verify that vCenter Guided Consolidation, vCenter Update Manager, and vCenter Converter are configured using Fully Qualified Domain Names (FQDN).</td>
</tr>
<tr>
<td></td>
<td>Verify that the server has 1GB of RAM minimum (Recommended 2GB) in addition to any other memory requirements for the Operating System or vCenter Server.</td>
</tr>
<tr>
<td></td>
<td>Verify that the server has at least 2GB of available disk space on the drive where vCenter Server Heartbeat will be installed.</td>
</tr>
<tr>
<td></td>
<td>Verify that the user account used to perform the installation has local administrator rights.</td>
</tr>
<tr>
<td></td>
<td>Apply all current Microsoft security updates.</td>
</tr>
<tr>
<td></td>
<td>All applications to be protected are installed and configured on the server.</td>
</tr>
<tr>
<td></td>
<td>Verify that both the Primary and Secondary server have identical system date, time, and time zone settings.</td>
</tr>
<tr>
<td></td>
<td>Verify that the Principal (Public) network adapter is listed as the first network adapter in the connections binding order.</td>
</tr>
<tr>
<td></td>
<td>Verify that the Managed IP setting in the Virtual Infrastructure Client is the same IP address used for the vCenter Server Heartbeat Principal (Public) IP address.</td>
</tr>
<tr>
<td></td>
<td>The Secondary virtual machine CPU (including resource management settings) is similar to the Primary server.</td>
</tr>
<tr>
<td></td>
<td>The Secondary virtual machine memory configuration (including resource management settings) is similar to the Primary server.</td>
</tr>
<tr>
<td></td>
<td>The Secondary virtual machine resources pool priorities are similar to the Primary server.</td>
</tr>
<tr>
<td></td>
<td>The Secondary virtual machine Operating System and Service Pack are identical to the Primary server.</td>
</tr>
<tr>
<td></td>
<td>All VMware components are bound to the Principal (Public) IP address on the Principal (Public) network adapter and the Principal (Public) network adapter is listed first in the bind order.</td>
</tr>
<tr>
<td></td>
<td>If installing with vCenter Server and SQL Server on the same host, vCenter Server and SQL Server are installed on separate physical disk drives.</td>
</tr>
<tr>
<td></td>
<td>The Primary server's Principal (Public) NIC is configured with a static IP address, correct network mask, correct gateway IP address, correct preferred and secondary (if applicable) DNS server address.</td>
</tr>
</tbody>
</table>
The Primary server's VMware Channel NIC is configured with a static IP address in a different subnet than the Principal (Public) network, correct network mask, no gateway IP address, no DNS server IP address, and NetBIOS is enabled (disabled by setup during the installation process).

The Secondary server has the same number of NICs as the Primary server.

The Secondary server's Principal (Public) NIC is configured with temporary network settings.

The Secondary server's VMware Channel NIC is configured with a static IP address in a different subnet than the Principal (Public) network and has a different IP address that the Primary server's VMware Channel NIC.

The Secondary server's VMware Channel NIC is configured with the correct network mask, no gateway IP address, no DNS IP address, NetBIOS is enabled, and File and Print Sharing is enabled.

All firewalls have been configured to allow traffic on both the Client Connection port (52267) and the Default Channel port (57348).

<table>
<thead>
<tr>
<th>Checked</th>
<th>Description of Items to be Checked</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The Primary server's VMware Channel NIC is configured with a static IP address in a different subnet than the Principal (Public) network, correct network mask, no gateway IP address, no DNS server IP address, and NetBIOS is enabled (disabled by setup during the installation process).</td>
</tr>
<tr>
<td></td>
<td>The Secondary server has the same number of NICs as the Primary server.</td>
</tr>
<tr>
<td></td>
<td>The Secondary server's Principal (Public) NIC is configured with temporary network settings.</td>
</tr>
<tr>
<td></td>
<td>The Secondary server's VMware Channel NIC is configured with a static IP address in a different subnet than the Principal (Public) network and has a different IP address that the Primary server's VMware Channel NIC.</td>
</tr>
<tr>
<td></td>
<td>The Secondary server's VMware Channel NIC is configured with the correct network mask, no gateway IP address, no DNS IP address, NetBIOS is enabled, and File and Print Sharing is enabled.</td>
</tr>
<tr>
<td></td>
<td>All firewalls have been configured to allow traffic on both the Client Connection port (52267) and the Default Channel port (57348).</td>
</tr>
</tbody>
</table>